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Embroidery Essentials Webinar 16 
 

Day 1 
 

 

 

Welcome to our Embroidery Essentials Webinar. Today’s webinar will use a combination of written instructions as well as visual 

demonstrations. This document contains all the information that will be covered in detail. 

 
It takes more than a great machine to produce great embroidery. There are several factors that go into the process, including 

proper thread tensions, the right needle, appropriate backing, hooping techniques, quality design creation setup, proper software 

settings, etc. We will learn all of these variables, what they are and how they interact. We categorize these variables into what we 

affectionately call the 3 P’s of Embroidery Perfection. 

 
 
 

 

reparation of the Garment 
 

You will learn how to compensate for the negative characteristics of the garment using Backing, Topping and Needles. 
 
 
 

 

lanning the Design 
 

You will be introduced into the Tajima DG/ML by Pulse software and cover basic design creation as well as elemental 

editing files. 

 
 
 

 
 



 

Stretch and Give 
 

Garments that Stretch 

• Knit Garments 

• Tee Shirts 

• Fleece 

• Sweaters 

• Pique Polo Shirts 

 

 

 
 

 

Understanding Different Materials is perhaps one of the greatest challenges an embroiderer must learn. 

The reasons for this are simple: 

1 - There will be a variety of fabric types that your customers will ask you to embroider on. 

2 – With all the different hooping aids available on the market today, you can embroider on virtually any object! 

 
So, to get you started thinking in the right direction, I’ve split fabrics into separate categories based off of certain characteristics: 

Stretch and Give, Bulk and Thickness and Surface Texture. 

 
 
 

Garments that won’t stretch 

• Woven Garments 

• Twill 

• Denim 

• Non Woven Garments 

• Felt 

• Terry Cloth 

• Leather 

• Suede 

   
 
 
 

Any type of knit garment will stretch and give even when the garment is hooped.  This is because of the fibers used and also how 

those fibers were woven together. 

After the training today, pick up a tee shirt that you have and gently tug the garment by pulling your hands apart. Notice how easy it 

is to stretch. 

 
Woven Fabrics and Non – woven fabrics are very stable because they do not stretch and give. 

Again, pick up a denim shirt or a leather jacket and gently tug the garment by pulling your hands apart.   Notice that the fabric 

doesn’t stretch and resists the pull. 

Preparation of Garment 

Fabric Characteristics 



 

Bulk and Thickness: 

 
Thick/Bulky Garments 

 
• Fleece 

• Towels 

• Blankets 

• Sweaters 

• Wool 

• Faux Fur 

 
 
 

 
Thin Garments 

• Tee Shirts 

• Linen 

• Cotton 

• Silk 

• Satin 

   

 
Thick / bulky fabrics are generally soft and allow the stitches to sink into the material.  The result will affect the overall coverage of 

your stitches and in some cases, cause the stitching to shift on the pile of the fabric. 

 
With thin garments, great care is taken to ensure that there aren’t too many stitches to eat the fabric up causing puckering around 

the design, birdnests or runs in the fabric. 

 

 
 

A smooth unbroken surface provides a stable platform for the stitches to sew on. 

 
A fabric that has a rough surface texture will cause the stitches to lie somewhat haphazardly on 

the fabric, causing the edges of letters to look uneven and jagged. 

Smooth Fabrics Textured Fabrics 

Surface Texture: 
 
 

• Tee Shirts • Fleece 

• • Towels 

• Cotton • Sweaters 

• Silk • Pique 

• • Faux Fur 

• • Wool 

• • Felt 

• • Terry Cloth 

• Twill 

 
 
 

Some of the fabrics are included in

multiple groups. Careful attention

should be paid to ensure good quality

embroidery. 



 

 
 
 

To ensure that you do not cut

into the garment when you are 

removing the backing – turn the 

shirt inside out. 

 

 

Now, that we’ve explored the negative characteristics of fabrics, let’s discuss how we can compensate the fabric. 

One of the most important items to consider is Backing. Backing or stabilizer is a fabric material that is placed behind the garment 

and hooped with it. Backing material is very stable and won’t shift or stretch during the hooping process or even the sewing process. 

During the sewing process, the backing material is attached by the stitches thus transferring the stable characteristics to the 

garment and anchoring the fabric in place. 

Backings also improve detail stitching. 

 
There are basically 2 groups of backing to choose from – cutaway and tearaway. Both styles come in different weights, colors and 

sizes. The difference comes from its function. 

 

Cutaway Backing 
 

Sample Fabrics to use Cutaway Backing 

• Tee Shirts 

• Sweatshrits 

• Sweaters 

• Pique Polo Shirts 

• Spandex - including fabrics with cotton/spandex blend 

• Underarmour / Moisture wicking shirts 

 
Cutaway Backing is typically a non woven material and cannot be torn. Therefore, it is permanently attached to the garment during 

the sewing process. This provides the best stability to your garment and thus should be used on unstable garments. Once the 

garment is laundered, the cutaway backing will soften considerably, much like a dryer sheet. 

 
How to use it 

When using Cutaway backing, you will choose a piece larger than the hoop you will use. Place it under the garment and hoop it with 

the garment. 

 
How to remove it 

Once the sewing process is completed, you will cut away any excess backing, leaving approximately .25” around the design. 

You will need to take care that you do not cut into the actual garment while cutting the excess backing and you can round any sharp 

corners to give a smooth corner. 

Backing 



 

 
 
 
Tear in the opposite direction of the 

stitches of a design that contains

long satin stitches. This will keep

the stitching from pulling with the 

backing. 

 

Tearaway 
 

Sample Fabrics to use Tearaway Backing 

• Blankets 

• Towels 

• Leather 

• Suede 

• Caps 

• Bags 

• Denim 

• Twill 

 
Tearaway is typically a paper type material and can be “torn” away from the garment, so the stable characteristics of this backing is 

only temporarily applied. Therefore, the fabrics that you apply tearaway backing should be stable enough to hold the stitching after 

the backing is torn away. It is most commonly used for fabrics where the back of the embroidery design will be seen. 

 
How to use it 

When using Tearaway backing, you will choose a piece larger than the hoop you will use. Place it under the garment and hoop it 

with the garment. 

 
How to remove it 

Once the sewing process is completed, you will simply tearaway it away from the item. 
 
 
 
 
 
 
 

 

Specialty Backings 
     
 

No Show Polymesh 
 

Peel 'n Stick 
 

• Light Colored Garments 

• Spandex 

• Underarmour 

• Moisture Wicking Garments 

• Caps 

• Bags 

   

We also have specialty backings available for those really specific applications: No – Show Polymesh and Adhesive Backing. 



 

 

 

Use the No Show for garments that need a Cutaway backing, but you don’t want to see the outline through the garment.  One of the 

rapidly growing uses of the no show backing is on the 100 % polyester or moisture wicking garments. These garments are very much 

like spandex and that they will stretch whichever way and no matter what type of backing you use. But, with the No Show 

Polymesh, you can iron the backing from the inside of the shirt and it will smooth the wrinkling around the embroidery design. 

 
 

 
Make sure to use a damp paper 

towel or wax paper between the 

iron and the backing. This will 

ensure that you do not burn the 

polyester material. 

How to use it 

When using No Show Polymesh backing, you will choose a piece larger than the hoop you will use. 

Place it under the garment and hoop it with the garment. 

 
How to remove it 

Once the sewing process is completed, you will cut away any excess backing, leaving approximately 

.25 ” around the design. 

You will need to take care that you do not cut into the actual garment while cutting the excess backing 

and you can round any sharp corners to give a smooth corner. 
 

 

The Peel N Stick backing is a form of tearaway backing and is especially popular for bags. It is used primarily on the clamping 

systems or the quick change frames. Just remember that it does have an adhesive side and therefore it is not recommended for 

garments with nap. It may accidentally leave a bare spot. 

 
How to use it 

When using Peel ‘n Stick backing, you will choose a piece larger than the hoop and place it under the garment and hoop; or if you 

are using it with your clamping system, you will choose a piece larger than the window you want to use. Place the sticky side face up 

and then press the garment into the sticky backing. 

 
How to remove it 

Tear away any excess backing just as you would for regular tearaway backing. 

No Show Polymesh 

Peel ‘n Stick 

 
 
 

Because it has an adhesive side,

it is not recommended on fabrics

with nap or loose fibers. It may

accidentally leave a bare spot on

the fabric. 



 

 

Backing Guidelines 
 

Choosing A Weight 

• Thick/bulky garments require heavier weight backing 

• High stitch count designs require heavier backing 

• Thin fabrics require light weight backing 

• Low stitch count designs require lighter weight backing 

Choosing Sizes 

• Backing can be purchased precut or by the yard. 

• If you find that you embroider mostly left chest size designs, go with the precut backing to 
save you time cutting. 

• If you do many different size embroidery designs and different applications, you will benefit 
from cutting your own backing to fit your design size. Stay away from trying to piece 
together backings. This truly defeats the purpose of using a backing at all. 
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Toppings 
 

Sample Fabrics to use Toppings 

• Cordoroy 

• Pique Polo Shirts 

• Scultured Knits 

• Large Twills 

• Terry Cloth 

• Towels 

• Fleece 

• Velvet 

• Faux Fur 

• Fluffy Materials 

 

Topping is a special material – usually water soluble that is placed on top of your garment before being hooped. It looks very much 

like plastic kitchen wrap but is not clingy and will melt when it is wet. You use toppings to prevent the edges of your design from 

sinking into the material by offering a flat surface for your stitches to sew on. 

 
After the sewing process, un-hoop the garment and tearaway as much as you can of the topping. You can use a steamer or a misting 

bottle to get the remaining topping damp, then use the topping that you ripped off earlier and blot at the garment. The remaining 

topping will lift right off the garment. Take care that you don’t rub. The topping becomes very gluey and will smear across the 

garment if you rub. 

 
How to use it 

Place the topping on top of the garment and then hoop it. Embroider your design as usual. 

 
How to remove water soluble topping 

After you un – hoop your garment, tear off as much of the topping as you can.  Then use a spray bottle with water and mist it lightly 

or steam for a couple of seconds. Take what you’ve ripped off and bloat at the remaining pieces. It will lift right off the garment. 

 
How to remove melt away topping 

After you un – hoop your garment, lay a paper towel on top of the melt away. Iron on medium setting with no steam or water until 

the melt away becomes little flakes. Then simply brush them off the garment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



 

 
 

 
75/11 Ballpoint

Needles come 

standard in all Tajima

Machines. 

 

 
 

 
Needle Size 

 
Needle Point 

 
System Number 

 

•Needle Size denotes the 
diameter of the blade or 
shaft. 

•Sharp 

•Ball 

•Wedge 

•Denotes size of needle and 
size of the eye 

 
 

Another important item to consider when compensating for these fabric characteristics are needles.  There are several different 

variables to consider when selecting a needle: application, current needle size in use, thread type and weight and needle eye size. 

A needle has 3 defining characteristics: needle size, needle point, and system number. 

 
Needle Size 

Needles size denotes the diameter of the blade or shaft.  The size that you would select to use is dependent upon the thick/stiffness 

of the fabric as well as the thread weight. In general, the larger the needle the larger the eye. 

The larger the needle size, the larger the blade and hole made in your fabric. The result is a stronger needle. 

For heavy, stiff fabrics, a larger size needle should be selected. 

For lightweight fabrics, a smaller needle can be used. 

 
Needle Point 

SHARP: Typically used for tightly woven fabrics, such as denim, twill, towels or corduroy.  As the needle passes through the fabric, it 

may actually cut fibers.   However, since these garments are tightly woven, this is generally not a 

problem. 

 
BALL: Typically used for knit goods, fleece and delicate fabrics. The tip of this needle is smoothed so 

that when it passes through the garment it will push the fibers aside, allowing the fibers to close back 

around the thread. 

 
WEDGE: Typically used for tough non – woven fabrics, such as leather.  It cuts as it passes through the 

fabric and reduces friction. 

 
Needle System Point 

Another descriptive term for needles, it is a combination of numbers and/or letters referring to the total length of the blade and size 

of the needle eye. 

 
DBxK5 – Standard for commercial embroidery machines. 

 
DBx7ST – Has a larger eye that is elongated and rectangular in shape. Most common use is with metallic threads. 

DBx9ST – Needle eye is twice the size of the DBxK5 and is useful for heavy embroidery threads. 

Needles 



 

Below is a recommendation chart for choosing the most appropriate needle for the fabric that you will be embroidering. 
 

 
 

 
Now, that we’ve explored all the variables that contribute to garments, let’ put it all together. 

Here are some samples of what you would use for different garments. 

 

{Garment Name} CAP 

 

 
 
 
 
 

{Placement} 

 
 
 
 
 

FRONT 

{Needle Information} 
75/11 DBxK5 

Sharp Point 

{Design Max Size} 

WIDTH: 12.50 inches 

HEIGHT: 2.25 inches 

{Backing} Tearaway 3.0 oz 

{Topping} N/A 



 

 

{Garment Name} 
Shirt: Tee Shirt, Polo, Sweatshirt, 

Placket, etc. 

 

 

 

 

 

 
{Placement} 

 

 

 

 

 
Left Chest 

{Needle Information} 
75/11 DBxK5 

Ball Point 

{Design Max Size} 

WIDTH: 4.00 inches 

HEIGHT: 4.00 inches 

 
{Backing} 

Cutaway 2.5 oz 

(can substitute with 2 ply 1.0 oz No 

Show Polymesh) 

{Topping} N/A (unless loosely woven) 

 

 
 

{Garment Name} Towel: Hand, Finger, Bath 

 

 

 
{Placement} 

 

Front Bottomed Centered 

<or> 

Caddy Cornered 

{Needle Information} 
75/11 DBxK5 

Sharp Point 

{Design Max Size} 

 
WIDTH and HEIGHT: choose most appropriate for size and 

location of design 
{Backing} Tearaway 2.0 oz 

{Topping} Melt Away 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

 

 
{Garment Name} 

Sweatshirt 

<or> 

Jacket 

 

 

 

 

{Placement} 

 

 

 

Back Centered 

{Needle Information} 
75/11 DBxK5 

Ball Point 

{Design Max Size} 

 
WIDTH and HEIGHT: choose most appropriate for size and 

location of design 
{Backing} Cutaway 2.0 – 2.5 oz 

{Topping} N/A 

 

 

 
 

 
{Garment Name} 

Sweatshirt 

<or> 

Jacket 

 

 

 

 
{Placement} 

 

 

 
Front Centered 

{Needle Information} 
75/11 DBxK5 

Ball Point 

{Design Max Size} 

 
WIDTH or HEIGHT: choose most appropriate for size and 

location of design 
{Backing} Cutaway 2.0 – 2.5 oz 

{Topping} N/A 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

 

 

This section will focus on how to plan and create basic embroidery designs.  We will start with an introduction into the software and 

then cover the essential tools you will use regularly to create such designs as namedrop, monogram, name – stacking and templates. 

User Interface Changes 

New Ribbon Interface  
The ribbon is a new innovation of the Tajima DG16 workspace. The Ribbon appears along the top of the 

workspace. This area includes a number of different tabs, which take the place of the menus in former 

versions of DG by Pulse. The Ribbon is turned on by default; to turn it off and use the conventional menus and 

properties panel, go to Tools—User Settings—Environment—Display, and uncheck “Use ribbon interface.” 

For example, there is a tab listing all the File functions, one for Manage functions, and another for Librarian 

tools.  

 

There also tabs for Tools, Processing, Generation, Segment, Auto, Image, and Hoop. 

The Ribbon is also context-sensitive, which is to say, the tabs that appear there will change depending on 

what kind of segment is selected. For example, whenever a new file is opened, the Design Properties tab will 

appear on the ribbon. 

 

Then, when a segment is added and selected, the Properties tab will open, and show the properties particular 

for that segment. So, if an artwork shape is selected (for example) the Ribbon shows only those properties 

that apply to artwork segments.  

 

Then, if Text is selected, you will see a different set of settings. 

Planning the Design 



 

 

Similarly, the contents of the ribbon will change for all segment type – whether it be a fill, cross-stitch, or any 

other. 

Toolbar Reorganization 
The Tajima DG16 by Pulse toolbars have been re-organized to improve clarity. Many of them have been 

changed to work as “fly-out” toolbars – that is, you click on the toolbar to open all the tools that it contains 

(see example below). This change has been made to simplify the workspace view when many toolbars are 

open. 

 

Example of a “fly-out” toolbar – in this case, the Node Edit tools. 

As well, the artwork for most of the tool icons has been updated. 

User Settings 

Customize & Restore Recommended Settings 

The Tools menu now has a “Restore Recommended Settings” option. This allows the user to restore the 

settings in the “User Settings” dialog to the defaults, if they have been altered. To personalize the user 

settings, go to Tools—Configuration—User Settings—Customize… 

Product level availability: All 

Highlight color overrides 

There are two new options for how tools will be highlighted when digitizing – “Override Tool Color” and 

“Override Tool Highlight Color.” 

• The Override Tool Color setting allows you to choose the color that will be used for the anchors and 

lines of a segment as it is digitized with any digitizing tools. 

• The Override tool highlight Color setting allows you to choose the color that will be used to highlight 

control points (e.g., the “handles” that are used to control the shape of Bezier curves) when you select 

them with the vertex select tool. 



 

These color overrides may be implemented in the User Settings. Go to Tools—Configuration—User Settings—

Customize—Environment—Display colors; these overrides are found in Tools area of the Display Colors page. 

 

 

When you start up the Tajima DG15 by Pulse software, you can immediately begin creating your design. As with any software 

program, you can start a new file and create it from scratch or you can open an existing design – one that you purchased from an 

internet stock design distributor or from a digitizer. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Start Page 



 

 

 

If you choose to start a new file and create from scratch, you have the option of choosing a Blank Design or using the New Design 

Wizard. 

 
To create a new file: 

1. Do one of the following: 

a. From the Start Page, choose 

New file… 

 
b. Choose File – New. 

 

 

c. In the File toolbar, click the 

New Page tool . 

d. Press Ctrl + N. 
 
 

 
2. If you choose Blank Design, the Normal Recipe is applied and there are no presets. 

3. If you choose New Design Wizard, you will be guided through choosing a recipe and settings for the design. 

a. First you will choose a Recipe. 
 

Recipes are a collection of fabric types that contain preprogrammed settings based on the size of the design. These settings include 

density, pull compensation and underlay. These 3 settings are called Stitch Control Factors and will need to be adjusted for every 

different type of fabric. 

 
DENSITY: refers to the amount of stitch coverage over a given area. 

PULL COMPENSATION: an adjustment of the stitch length to compensate for the pull of the stitches on the fabric 

UNDERLAY: the preliminary stitches that sew prior to and underneath your design creating a foundation for the top stitches to lay on 

 

The complete list of recipes includes: 

- Baby Blankets 
- Canvas 
- Cap 
- Dog Collar 
- Fake Fur 
- Fleece 
- Global 
- Jeans 
- Leather 

 

- Lycra 
- Normal (default) 
- Pique 
- Pullover 
- Satin 
- Shirtcuff 
- Silk 
- Sweatshirt 
- T-Shirt 

 

- Towel 
- Velvet 
- Vinyl 
- Woven Fabrics 

 
 
 
 
 
 
 
 
 
 

When in doubt of 

which Recipe to use, 

try the Woven 

Fabrics. 

Creating a New File 



 

b. Then you will choose a Machine Format. 
 

  
 

c. Next, you will choose if you want a preset on the punching tools. This is only applicable in Creator, Illustrator 

Extreme and Maestro Multimedia levels of Tajima DG/ML by Pulse. 

 

 
d. Then, you will choose the design’s start and stop location.  This should always be set to “positioned in the center of 

the design” unless you are digitizing the design differently. 

 

 
e. Lastly, you will have the option of savings your set as a favorite or a default that you can select quickly for reuse 

later. 

 

 

 
 
 
 

At any time you can

choose to finish and exit

the Design Wizard. 



 

 

 
 
 

 

By default when you install the Tajima DG/ML by Pulse software onto your computer, it sets the measurements as metric. 

 
1. To change this to inches, go to Tools > Configuration > User Settings > Units. 

2. Click OK. 

 

 
 

3. For the changes to take effect, you must close the window and open a new one 

 
4. When the new window opens, it will look large.   You 

have to reset the grid to inches as well. 

5. Right click on the ruler at the TOP or the LEFT side of the 

WORKSPACE. You will see the Grid Settings box pop up. 

6. Change the Horizontal and Vertical Spacing to 1.00 in 

and you can choose the color you want it to show up on 

the screen as. 

7. Click OK. 

8. These changes will immediately be applied and do not 

require opening a new window. 

Changing the Units from Metric to Inches 



 

 

 

In embroidery, we work with two groups of files – outline and stitch. 
 

   

Outline Files 
 

 

The outline file contains the framework – outline – of your design. If we take the outline file and resize it, our stitch count increases 

and vice versa. The stitches we see on our screen are a simulation of the actual stitches. 

 
There are 4 different outline format files that Tajima DG/ML by Pulse will read: 

 
 .PED .KWK .CND .PXF 

 

 

Stitch Files 
 

 

The stitch file contains fixed in placed stitches. If we 

resize this file, it will take the same number of stitches 

and stretch them over a larger area or compress the same 

number of stitches into a smaller area thus resulting in 

poor sewing quality. 

 

This is the command file that the machine must have in 

order to sew your design. Every stitch is placed on a (X, Y) 

graph and has a coordinate number. We take this file to 

the machine and line up our needle to the middle of the 

hoop setting our (0, 0).  The machine will then read and move your frame to begin sewing your design at the (X, Y) number per stitch 

in the correct location. 

 
For every embroidery machine on the market today, there is a specific stitch file.  There are over 20 different stitch format files that 

Tajima DG/ML by Pulse will read. 

 
.PSH .PCH .DST .ART .JEF .EXP 

Files of Type – Data Files 



 

 

 

A segment is a single section of an outline or stitch file – much like a puzzle piece to the overall design. 

In an outline, the segment is composed of one type of stitch. A complete design will have many segments in an outline file. 

In a stitch file, the segment is a group of stitches, broken up only by machine commands, color change, trim or origin. 

 
There are 4 basic types of segments that are used for embroidery – run, satin path, complex fill and stitch segment. The run, satin 

path and complex fill segments are found in outline files only, as they are really an area with stitch information. They are easily 

modified by changing the assigned properties. 

Stitch Segments are found in both outline and stitch files. They are fixed – in – place stitches; therefore, the edits made are limited. 
 
 

 

Run Stitches: walking stitch that travels along 

the outline; defined by stitch length – 

distance between 1st needle penetration and 

next 

• Min. Stitch Length 0.03in 

• Max. Stitch Length 0.20in 

Used For: 

• Fine detail 

• Underlay 

• Traveling Route 

 

 

Complex Fill Stitches: run stitch that travels 

from one side of the column to the other, 

offsetting the stitch lengths to give you a 

pattern 

No min/max because stitch length is 

preprogrammed 

Used For: 

• Large Areas 

• Complex 

Shapes 

 

 

Stitch Types 

Satin Path Stitches: zigzag stitch that travels 

from one side of the column to the next;

defined by density – number of stitches filling 

in – and column width – the length of the

stitch, and angle lines – direction of the

stitches 

Used For: 

• 

• 

• 

Lettering 

Small Areas 

Thick Borders 

(Steil) 

• Min. Column Width 0.04 in 

• Max. Column Width 0.50in 

Stitch Segments: contains fixed – in – placed 

stitches. For this segment, you will have to 

edit one stitch or a group of stitches 



 

 

 

Below is a quick reference to the most commonly used keyboard shortcuts. The character in parentheses denotes the actual 

keystroke. 

 
 

Viewing Tools 
 

 

 
 

• (Z) = Zoom 

Left Click = Zoom In 

Right Click = Zoom Out 

 
• (2) = Fit to Window 

• (V) = View by Color • (Ctrl) + (M) = Measure Tool 

• (1) = Back to 1:1 • (4) = Fit Selection to Window 

• Display Hoop • Draw Ribbon 

• (3) = 3D  

 
 

 

General Tools 
 

 

 
 

• (G) = Generate Stitches • (SHIFT) + (G) = Generate All 

• (S) = Select Tool • (CTRL) + (G) = Group Segments 

• (CTRL) + (Y) = Redo • (CTRL) + (U) = Ungroup Segments 

• (CTRL) + (Z) = Undo • (CTRL) + (R) = Resize 

• (CTRL) + (C) = Copy to Clipboard • (CTRL) + (T) = Rotate 

• (CTRL) + (X) = Cut to Clipboard • (CTRL) + (F) = Reflect 

• (CTRL) + (P) = Paste from Clipboard  

Shortcut Keys 



 

 

 

Creating lettering and text is perhaps the most common function that you will perform. You can create a variety of lettering “looks” 

and layouts by using the various lettering tools in your software. Each lettering tool creates a unique platform or baseline that the 

text will sit on. 

 

There are six different lettering tools in the Tajima DG/ML by Pulse software as follows: 
 

1. Line Angle 

2. Line Vertical 

3. Arc 

4. Circle 

5. Three Letter Monogram 

6. Text 

 
The Line Angle, Line Vertical, Arc, Circle and 3 Letter Monogram Tools all use a box type baseline which creates single or multiple 

lines of text horizontally or vertically. The Text Tool creates a free style baseline for the lettering. 

 

 
 
 

 
 
 

To Create Text Using the Line Angle Tool: 
 

- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to 

your line); drag down if you wish the lettering to be at an angle 

- Left click to confirm the length angle 

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing) 

- Left click to confirm the height 

- The Text Box appears – type in the desired text. 

- Click OK. 

Text – Creation 

Line Angle 



 

 

 
 
 

 

 

To Create Text Using the Line Vertical Tool: 

 
- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to 

your line); drag down if you wish the lettering to be at an angle 

- Left click to confirm the length and angle 

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing) 

- Left click to confirm the height 

- The Text Box appears – type in the desired text. 

- Click OK. 

 

 
 
 

 
 

To Create Text Using the Arc Tool: 
 

- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to 

your line); drag down if you wish the lettering to be at an angle 

- Left click to confirm the length and angle 

- Move the mouse up to set the radius (curvature) of the baseline ( you will see the radius next to the line you are drawing) 

- Left click to confirm radius 

- Move the mouse up to set the height of the lettering (you will see the height next to the line that you are drawing) 

- Left click to confirm the height 

- The Text Box appears – type in the desired text. 

- Click OK. 

Line Vertical 

Arc 



 

 

 

- Left and drag one of the four square boxes to edit the shape of the baseline 

 

 
 
 
 

 
 
 

 

 
To Create Text Using the Circle Tool: 

 
- Left click and drag straight up to set the size of the first circle. As soon as you let go of the mouse, the baseline size is 

confirmed. 

- Move the mouse up to set the height of the lettering. Again, as soon as you let go of the mouse the height is confirmed. 

- The Text Box appears – type in the desired text to appear on the top of the circle in the upper text and the desired text to 

appear on the bottom of the circle in the bottom text. 

- Click OK. 
 
 
 
 
 
 
 
 
 

 

To Edit the Arc Baseline: 

Circle 



 

 

 

- Left and drag one of the four square boxes to edit the shape of the baseline 

 

 
 
 

 

 
 
 

 
 
 
 

To Create a 3 Letter Monogram: 
 

- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline (you will see the length and angle that you are drawing next to 

your line); drag down if you wish the lettering to be at an angle 

- Left click to confirm the length and angle 

- Move the mouse up to set the height of the lettering (the height that you are setting is for the Last initial – the middle 

letter) 

- Left click to confirm the height 

- The Text Box appears – type in the desired text: First initial – Last initial – Middle initial. 

- Click OK. 

To Edit the Circle Baseline: 

Three Letter Monogram 



 

 

 
 

To Add a Decoration to a Monogram: 
 

- Choose a Font that has a decoration included (refer to the Font Help Section) 

- Type in the keystroke for that particular decoration in the box on the Property Bar 

- Hit the (ENTER) key on the keyboard 

 

 
 
 

 
To Create a 3 Letter Monogram using a Regular Embroidery Font with a Decoration: 

 
- Choose the Three Letter Monogram Tool 

- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline (refer to the Status Bar for exact length); drag down if you wish the 

lettering to be at an angle 

- Left click to confirm the length and angle 

- Move the mouse up to set the height of the lettering 

- Left click to confirm the height 

- The Text Box appears – type in the desired text. 

- Click OK. 

- Change the font to the desired font. 

- Choose the Line Angle Tool 

- Left click and Right click on the workspace. 

- Type in the keystroke for the desired decoration 

- Left click on OK. 

- Change the font of the decoration to the corresponding Monogram Font. 

- Move it to the desired position in relation to the 3 Letter Monogram 



 

 

 
 
 

 
 
 

 

To Create a Straight Baseline: 
 

- Left click once on the workspace to start the baseline 

- Move the mouse across to set the length of the baseline and hold (SHIFT) to keep it straight 

- (ENTER) to complete the baseline 

- Type in your desired text 

- Click OK 
 

Another way to create a Straight Baseline: 
 

- Left click once on the workspace to start the baseline 

- Press (ENTER) to complete the baseline 

- Type in your desired text 

- Click OK 
 
 

 
To Create a Curved Baseline: 

 

- Left click once on the workspace to start the baseline 

- Move the mouse across to and up 

- Left click and drag – you will see handles stretch from the point – the further you drag the more 

curved the baseline becomes 

- Continue until you have the desired baseline 

- (ENTER) to complete the baseline 

- Type in your desired text 

- Click OK 

Use BACKSPACE to 

delete the previous 

point. 

Text 



 

 

 
 
 
 



 

 
 

 
If the Preview shows 

only Capital Letters,

that font only has 

Capital Letters. 

 

Once you’ve created your text on your screen, you will want to make slight adjustments to it. This next section will cover how to edit 

including spacing, color changes, justification. 

 

Changing Text   

Click in the Text box on the Property Docking Window and type in new 

text. Hit (Enter) to confirm. 

 

Changing Font   

You can change a font by left clicking o the drop down arrow next to the 

font name. You have many fonts to choose from including Blocks, Scripts, 

Two Color, etc. 

 
A preview of the font style will show on 

the right when the cursor is over  the font 

name. 

 
There are also some special categories of 

fonts: symbol fonts, stitch fonts and 

regular fonts that have addition special 

characters. 

 
Image Fonts: will show a design element instead of the keystroke typed.  

Stitch Fonts: are manually created fonts that are to be used at a specific 

height. 

3D Fonts: are digitized to embroider on top of foam for the puffy look. 

2 Color Fonts: will have two color changes per letter. 

Language Fonts: contain foreign characters – Greek, Hebrew, etc. 
 

Changing Height   

Adjust the height proportionally by clicking in the height box on the 

Property Bar and typing in the desired height. Hit (Enter) key to confirm 

new height. 

 

Font Help   

Refer to the Font Help files for vital information on the selected font. It 

will   show   a   preview   image,   available   keystrokes,   recommended 

minimum/maximum height of the font, any special characters the font may have included and suggestions on pull compensation, 

sewing etc. 

 
To view the Font Help, click on Help – Fonts. Double click on the Category and choose the desired font style. 

Text – Manipulation 



 

 

 
 

 
 

 

Kerning beads are the little dots on the bottom of each letter.  They allow you to manually move 

one letter to a specified spot along the baseline. 

 
You can also Group Space with the Kerning Beads. 

Hold the (SHIFT) key to move a particular letter and all the letters to the right of it as a group 

anywhere along the baseline. 

The cursor must be a 

triangle shape before 

you can left click and 

drag the letter. 

Hold the (CTRL) key to move a particular letter and all the letters to the left of it as a group anywhere along the baseline. 
 

 
 

 
to Picture on Previous Page) 

(Located on the Properties Docking Window, refer 

 
This setting is considered equal spacing because of the way it is applied to each character in the font. 

Spacing is determined by units named Em.  An Em is equal to 1/20
th 

of the widest letter of the font. 

• Input a positive number and the spacing increases between all characters. 

• Input a negative number and the spacing decreases between all characters. 

 

 
 

 

Window, refer to Picture on Previous Page) 

(Located    on    the    Properties    Docking 

 
Another way to space between individual letters is using the keyboard greater than (>) or less 

than (<) in the text box. 

Greater Than will increase the spacing, Less Than will decrease the spacing. 
 
 
 
 
 
 
 
 
 
 
 
 

Kerning Beads 

Equal Spacing 

Kerning Arrows 

 
 
 

The entered spacing 

values will be added/

subtracted to any

manually adjusted

characters. 



 

 
 
 

 

 
 

 
 
 

New Thread Palette/Chart Manager Features 
A number of tools and new features have been added to the Thread Palette/Thread Chart manager. These new 

features will make it quicker and easier to perform common editing tasks on charts and palettes, such as 

inserting threads, deleting threads, changing thread properties, and so on. 

• The thread data in each column may now be sorted in ascending or descending order. Click the column 

heading once for ascending order; click the column heading a second time for descending order. 

• An index column has been added to the thread data, so that the threads can be sorted in chart order. 

• Columns for thread thickness and thread type have been added to the data table. 

• Multiple threads can selected simultaneously (using the Ctrl+click or Shift+click shortcuts) and then 

edited. 

In addition, buttons and shortcuts for the following common functions have been added to the Thread Palette 

Manager: 

• New Thread  (Ctrl+N) 

• Insert Thread  (Ctrl+I) 

• Delete Thread  (Ctrl+D) 

• Import Thread  (Ctrl+R) 

• Edit thread  (Ctrl+E) 

Changing Color 



 

 

 
 

 
 

You can change the overall shape of the text using envelopes.  The envelopes are a set 

of predetermined shapes for the ‘bounding box’ of the text segment. 

To apply an envelope shape: 

1. Create the text on your screen. 

2. Click on the Envelope in the Properties Docking Window. 

3. Then click on the Dropdown Arrow next to the box and choose the desired 

shape. 

 

Rather than set up each line of text at the same 

time, Tajima DG/ML by Pulse has a built – in Multi 

– Line Text option that you choose from the Text 

Box. Type in as many lines of text needed. 

To create multiple lines of text: 
 

1. Choose a lettering tool and create the baseline and the height for the text. 

2. When the text box appears, left click on the Multiline option. 

3. Type in the first line 

4. Hit (Enter) to go to the next line 

5. Repeat as needed until you have all the lines you need. 

6. Check the Split lines into segments if desired. 

7.   Left click ok. 

Split lines into segments 

When you create multiple lines of text, they are automatically grouped together.  Whatever changes that you make to one line will 

be made to all the others, unless you check the box to Split lines into segments. 

Editing Multiple Lines of Text 

If you didn’t choose the Split lines into segments, the only way that you can edit your lettering is if you right click and choose Modify 

Text. 

Text Justify 

With multiple lines of text, you may want to justify or center them. 

Left Justify: will center the text flush on the left side 

Center Justify: will center the text down the middle 

Right Justify: will center the text flush on the right side 

Fill Baseline: will resize the height of the text to fill the baseline 

Fill Box: will stretch or compress the height and width of the text so that each 

line is the same dimension 

Envelop Text 

Multi – Line Text 



 

 

 

The Letter Bead will allow isolated manipulation to one letter in your text segment. 

You will want to make sure that the Show Beads is turned on. 

Click once on the Letter Bead (donut shape) to activate the editing box.  

Then, simply left click and drag on the corresponding bead to edit as desired. 

 

Letter Beads 



 

 

 

True Type Fonts are computer generated and are installed on the hard drive of your computer. You can use these fonts in any 

software program that uses true type fonts on your computer. Up until this point, we have been working with Embroidery Fonts. 

 
Embroidery Fonts may look exactly like a true type font but they are manually digitized to embroider. They have been push/pull 

compensated and guaranteed will sew well. True type fonts may need a little tweaking to get them to sew well. 

 

To change from the Embroidery Fonts to the True Type font list: Left click 

on the drop down arrow next Font Type in the Properties Panel. 

 
 
 

 

 
 

 

Steil Border is a satin type segment that outlines the path. You can 

adjust the width of the steil to keep the steil border proportional to 

the lettering. 

Check Scale width if you want the 

steil width to increase or decrease 

when you resize the text segment. 

 
 
 

You can also change the True Type font to appear as an Embroidery font. This will convert the complex fill to a satin path – allowing 

the stitches to sew in many different angles, contouring to the shape of the column. The software automatically places slice lines 

and angle lines. However, most times, these will need to be edited manually. 

 
To change from Complex Fill to the Satin path, click on the drop down arrow next to Fill 

Type in the Properties Panel and choose satin Path. 

 

 

True Type Fonts 

True Type fonts automatically use a complex fill stitch.   Therefore it is very easy to 

create a two color font or an outline only font. 

To change the border on the True Type Font: 

Click on the drop down arrow next to Border and choose one of the following: 



 

 

 
 

 
 

This may look wrong, but can save you a lot of time when having to sew out a long list of names. It is a technique called NAME 

STACKING.  Name stacking allows you to sew out single lines of text in the same placement but on different garments.  Now, instead 

of having each name as a single file, you have all names combined into one file. Each name is separated by a color change but is 

listed directly on top of each other. The technique is all in how the design is set up. 

 
To create the name stacking: 

 

First you will need to create an excel spreadsheet.  Each Column will represent a line.  For example, for one line name 
designs only have names typed under column A.  For 2 line names only have names in Column A and Column B might 
be  number of title. Save it as xls or xlxs 
 
You will also need to create a PXF file in Pulse with one name or name/number(2 lines) 
 
Once you have those saved:   
 

1) File New 
2) Click on Patches 
3) Choose the PXF file you wish to work with 
4) Number of Patches will be Number of Names to be stacked 
5) Click Box for Stop Between Patches 
6) For Offset Between Patches, Horizontal Spacing Will Be 0.00 IN, Horizontal Repeats will be number of Names to be 

Stacked.  Vertical Spacing will be 0.00 IN and Vertical Repeats will be 1  
 

 

Name Stacking With A Spread Sheet 



 

7) Click Next 
8) Click the Import Button and select you spreadsheet.  It will populate the list 

 

 
9) Click on Generate now to create the file. 

 
 
 
TIP: Make sure that the longest name fits inside the hoop that you want to use as well as the location on the garment. 



 

 

 
 

 
 

 

 

 

 

 

 

 

 

 
 



 

 

 

The Open command opens an existing (saved) file. You can open several different types of files with this feature.  Each time that you 

choose Open, another window is opened on your workspace. 

 
The Merge Design command will make a copy of the selected design (existing saved design) and allow you to place the copy on your 

current window. This is the most popular when working with existing designs because you can take many different files and place 

them all in the same window thus creating one new file. 

 
Both Open and Merge Design commands work with outline and stitch files. 

 
To open an existing design: 

 
1. click on File – Open. 

2. Choose the desired file and left click on Open. 

 

 
 
 
 

To merge an existing design: 
 

1. Click on File > Merge Design. 

2. Choose the desired file and left click on Open. 

3. Then, left click once on your workspace to place the design. 

 

 

 
 
 
 
 
 

 

Opening / Merging Designs 

 
 

 
You must have a window 

opened on your screen

for the Merge Design

function to operate. 



 

 

 

Saving your design allows you to access the design in the future to use again or make changes. 

 
You will want to save the design file twice – first in an outline format .PXF and second in a stitch format .DST. 

There are many different ways to save a file: 

SAVE: You can use this command if this is the first time that you are saving the design or if 

you have edited the opened design and want to save the update. 

 
SAVE AS: You can use this command if you wish to save the open file as a different name or 

as a different format. The new saved file is now current on your workspace. Any changes 

made thereafter will not be saved in the original file. 

 
SAVE AS COPY: You can use this command if you wish to save the open file as a different 

name or as a different format. However it differs from the SAVE AS function in that it does 

not open the new saved file on your screen. 

 

EMBROIDERY DISK: You can use this function to start up a wizard that will walk you 

through the steps to saving or importing a .DST file that is on an external device such as a 

floppy disk or flash drive. 

 

You can READ from an embroidery disk which will open a design file from an external device 

onto your workspace; you can WRITE to an embroidery disk which will save a design file to 

an external device. 

 
 
 
 
 

Then you will have to choose the location to save the file, name and type of file. 

 

 

Saving 



 

 

 

Templates are a great way to speed up repetitive design creation.   Any outline file can be used as a template file.  Start with a 

regular design, and then send it through the template function and…wala! 

Take this layout… …to this! 
 

 

 
 

 
 
 

First, you must select or create the master file of which you will use for the template files. Save the master file as an outline .PXF. 

Then you can go through the template function (steps below). 

1. Close all open files. 

2. Go to New File > Templates. 
 

 
3. Click OK. 

 

 
4. Click OK. 

Templates 



 

5. You should now have a window tab that reads Template1 with settings to adjust. As you can see all of the previous 

information is still completely changeable here. 

6. Under the Text boxes is where you can change the actual text that goes with each of the files that you are creating. 

7. After you have made the changes you want, simply click on Generate Now. 

 

 
 

 
Here is a screen shot of the files together just created. 

 

 
 

Make any necessary changes to spacing of the letters, etc. Be sure to resave that file afterwards as a .PXF. 

You will have to save each file independently as a .DST. 



 

 



 

 

 

The Print Preview function in Tajima DG/ML by Pulse products a production worksheet. Here you will have important information 

about your design documented for future reference. 

 
On the Production Worksheet, you can input valuable information like the design dimensions, color changes for the machine 

operator and cost of the design. 

 
Below is a sample Production Worksheet: 

 
 

 

 
To View: Menu Ribbon File > Print Preview 

 
To Change what prints: Settings in Print Preview 

 
To change your company name and estimate cost: Menu Ribbon Tools > Configuration > User Settings > User Preferences Tab 

To change design notes & your customer’s name: Menu Ribbon File > Design Properties 

Production Worksheet 



 

 

 

The Quotation Estimator is a software feature that guides you through the creation a customized Quote Sheet to give to your 

customer for approval of the image on a garment along with pricing and promised date. To start the Wizard, click on Tools > 

Quotation Estimator Wizard. 

 

1. The first step is choosing the design for the customer. Click on the Folder to select the embroidery file to use. The software 

will automatically generate a jpg thumbnail for the design and place it on your Quote. Click Next. 

2. The view/edit design statistics will be shown for the design. This will include the stitch count, trims and colors. You can 

change this is you want or you can leave it. Click Next to continue. 

3. You can set the machine speed, as well as the number of heads that you run in your shop. This will affect the time per item 

to create on the Quote. Click Next. 

4. You can set the pricing either by a number of stitches or by a fixed amount. You can even set the cost for material and 

digitizing as well. Click Next. 

5. Set customer details is where you input all your customer contact information for record keeping. Click Next. 

6. Set print settings will let you show your company logo and choose what information is shown on the printed quote. This is 

also where you choose the delivery date of your product. Click Next. 

7. Simulation Background: choose the garment or similar style garment to that which the customer is ordering for a more 

realistic view of the embroidery design. Click Next. 

8. Simulation placement: click and drag the logo to the desired place on the garment. 

9. Quotation preview lets you see the quote before you print it. Click finish to print. 

 

 
 

Quotation Estimator Wizard 



 

 
 



 

 
 
 



 

 
 



 

 
 



 

 
 



 

 
Hide fonts 

The complete list of fonts available in Tajima DG16 by Pulse is very long so it can take a while to look through them all. To 
save time while scrolling through the list when selecting a font, it is now possible to choose to display only the list of new-style 
fonts.  

To change this setting, go to Tools–Configuration— User Settings – Customize–Text; select “Display all fonts” to show both 
old and new styles, or select “Hide old fonts” to display only the new-style fonts. 

New Fonts 
The following table lists the new fonts available with Tajima DG16 by Pulse.  

 

Baxter 

 

Centennial 

 

Cursivo 

 

Glimmer 

 

Glow Light 



 

 

International 

 

Little Block 

 

Nobility Applique 

 

Nordique 

 

Outer Block 

 

Refined 

 

Roman 3 

 

Suave 



 

 

Swift 

 

Washington 



 

 

 

Let’s review how to create the first homework assignment. 

 
On the Production Worksheet, it told us some very important information; like the design colors, location and the fabric type. These 

are all key elements of any order and once we know this information, we can begin creating the design. 

 

Objectives: Create a design for the front of a cap. 
 

- Start a new file. 

- Choose a recipe. 

- Merge an outline file. 

- Add lettering. 

- Save the file in an outline format (PXF). 

- Re – Save the file in a stitch format (DST). 
 

Instructions: 
 

1. Start with a new file. 

2. Choose the appropriate recipe - CAP. 

3. Click OK. 

4. Go to File and choose Merge Design.  

5. Remember that you can click on Icons to preview the designs in the folder. 

6. Choose the design that looks like the balls & bats one in this design. 

7. Click on Open. 

8. Left click once to place the design on your workspace. 

9. You will have to resize the design smaller in order to add text to the design and have it still fit onto the cap. 

10. You should still be selected on the design, if not, left click and drag a box completely around the design. 

11. Left click and drag one of the 4 corners – look at the bottom of the screen as you drag to see the new dimensions. 

12. Let go when you are at 1.75 inches. 

13. Now, choose the Arc lettering tool. 

14. Left click to get started, move the mouse over and left click again to set the length. 

15. Now move the mouse up to set the radius or curvature of the baseline. Remember this is the line that the text will sit on. 

It’s ok if it’s not exactly lined up over the design, because we will adjust it later. 

16. Left click to set the radius. 

17. Move the mouse up again for the height of the lettering. 

18. Left click to set the height – 0.25 inches. 

19. Type in the text – Little League. 

20. Left click OK. 

21. Change the font to Brantford New. 

22. Now you can drag to move the text centered over the design. 

23. Save the file as a PXF and DST. 

24. Your design size should be the same as on the Production Worksheet. At this time, don’t compare the stitch count because 

we’ve not covered how to adjust the Embroidery Principals for designs. 

Homework Assignment #1 



 

 

 
 

 

 

 
 

 



 

 

 

Objectives: Create a design for the front of a T – Shirt. 
 

- Start a new file. 

- Choose a recipe. 

- Merge an outline file. 

- Add lettering. 

- Save the file in an outline format (PXF). 

- Re – Save the file in a stitch format (DST). 
 

Instructions: 
 

1. First we start off with a new file. 

2. Choose a recipe – T-Shirt. 

3. Left click OK. 

4. Next, let’s import our design. 

5. Left click on File – choose Merge Design. 

6. This design will be located in the Animals folder.  Remember you can left click on the Icons button. 

7. Open the design. 

8. Left click to place it on your workspace. 

9. You won’t have to resize this design because the sewable area is large enough to fit the design with the text. 

10. Choose the Line Angle Lettering tool. 

11. Left click to get started creating the baseline. 

12. Move the mouse across and left click to set the length. 

13. Now, move the mouse up to set the height - .50inches. 

14. Left click to confirm height. 

15. Choose the multiline button. 

16. Type ‘You Belong’. 

17. Hit (Enter) to move to the next line. 

18. Type ‘in the’. 

19. Hit (Enter) to move to the next line. 

20. Type ‘Atlanta Zoo’. 

21. Left click on OK. 

22. Change the font to Hobo New. 

23. Change the Text Justify to Left. 

24. Now just drag the text under the neck of the giraffe. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Homework Assignment #2 



 

 

 
 

 

 

 
 


